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What’s New

Over the next 3 months we will 
be exploring some of the new 
features in Apple’s applications. 
Come along to the March meet-
ing on the 4th and start the jour-
ney with an iTunes update.
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Courtesy of Apple

by Mark H. Anbinder

The low-end MacBook, the white 
13-inch polycarbonate model 

that remained in Apple’s laptop lineup 
when the company introduced a new 
unibody aluminum model, is now an 
even better deal. Without any fanfare, 
the company has quietly begun ship-
ping a revised MacBook that features 
more memory, more-advanced Nvidia 
graphics, and a faster frontside bus, 
without giving up the low price or the 
FireWire 400 port that keeps many 
users interested in the model.
Likely of most interest to prospective 
buyers will be the performance boost 
the low-end MacBook now gets from 
the combination of the Nvidia GeForce 
9400M graphics processor also used in 
the aluminum MacBooks, and a boost 
in the logic board’s frontside bus speed 
from 866 MHz to 1066 MHz. Oddly, the 
upgraded model also loses a little proces-
sor speed, dropping from a 2.1 GHz Intel 
Core 2 Duo processor to a 2.0 GHz Core 
2 Duo. We suspect the net result will still 
be a faster machine.
At the same time, Apple has increased 
base memory to 2 GB (upgradable to 4 
GB), and now offers not only the previ-
ously available 120 GB, 
160 GB, and 250 GB 
hard drives, but also a 320 

GB hard drive. The white MacBook re-
tains its Mini-DVI port, which supports 
adapters to DVI or VGA, but can’t drive 
Apple’s 30-inch Cinema Display. The 
aluminum MacBook model features the 
newer Mini DisplayPort, supporting 
DVI, VGA, and dual-link DVI with 
appropriate adapters.
The FireWire 400 port remains the big-
gest technical difference between the 
white MacBook (which has one) and 
the unibody aluminum MacBook model 
(which has none). The absence of a 
FireWire port from the aluminum Mac-
Book model was the subject of much 
consternation among users who felt 
they’d miss FireWire Target Disk Mode 
and compatibility with FireWire-based 
digital video camcorders, FireWire ex-
ternal hard drives, and other devices..

Apple Quietly Improves 
Low-End MacBook
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Editorial

As the power and speed of new computers 
increase software designers regularly 

upgrade their products to provide new features 
and take advantage of the increased capacity 
of the computer.
Apple recently released their ’09 editions 
of iLife and iWork at $129 each (just $79 in 
the US). Why does Apple not have an update 
path for these packages and, for that matter, 
their OS X updates? Microsoft offer upgrade 
packages for Windows Vista and their Offi ce 
suite but it won’t take you long to realise that 
those upgrades can cost as much or even more 
than the full price of the equivalent Apple 
software. The full price of Windows Vista 
can be from just over $100 to around $700 
depending which one of the staggering ar-
ray of versions you choose. Microsoft Offi ce 
presents a similar price range with the student 
version at around $150 and the professional 
pack closer to $800.
Adobe’s pricing is even more prohibitive with 
the new Creative Suite, CS4, costing anything 
from $2800 to over $5000. CS4 upgrade prices 
range from over $1000 to nearly $2000. These 
prices are typical of Adobe software and if, 
like myself, you started with an early version 
of Photoshop at around $1500 in to days terms 
and have upgraded regularly since that’s quite 
an expenditure. When you consider that design 
professional are almost obliged to follow the 
upgrade path budgeting for this would be a 
major decision particularly for a studio with 
many installations.
In the light of all of this the Apple approach is 
more than fair. I wouldn’t suggest that apple has 
any equivalent to the Adobe CS but iLife give 
users a very reasonable capability and iWork is 
more than just a cheap Offi ce substitute.
R. Lascelles
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Coming Up
Mark your calendar now for our upcoming 
events.
March 4 - iTunes Update
April 1 & May 6 - iMovie Update & iPhoto 
Update

Apple’s recent release of the iLife ’09 package 
means that there are many new and exciting features 
to be found in all of the individual programs in the 
package. Over the next few months we will be 

looking at some of the important new features 
in these and other packages. Come along to our 
March meeting at the Toowoomba Education 

Centre in Baker Street on the 4th for an update on iTunes.

Copyright 2009, TidBits Electronic Publishing.

by Glenn Fleishman

As expected, Microsoft announced layoffs 
last week, a rare event in the company’s 

history. The actual scale - 5,000 Microsoft em-
ployees and as many as 5,000 contractors - seems 
to have shocked analysts and reporters so much 
that they ignored a few salient facts.
Microsoft shed 1,500 employees at the time of the 
announcement and plans to lay off 3,500 more over 
the next 18 months. But, during the same period, 
CEO Steve Ballmer said in a staff memo the com-
pany will add 2,000 to 3,000 new positions for its 
new initiatives, many of which are focused on cloud 
computing, applications that run in a distributed 
fashion over the Internet instead of being housed 
on individual personal computers or servers.
Even more specifi cally, insiders are claiming 
that the majority of the first cuts are in the 
Xbox, Zune, and Windows Mobile divisions of 
the company, according to veteran Microsoft 
reporter Mary-Jo Foley.
We have no word yet at as to whether any 
Macintosh Business Unit staff have been let go. 
The MacBU develops core business and com-
munications software for Mac OS X, such as 
the Offi ce suite.
It’s well known in the Seattle area that Microsoft 
has a penchant for hiring and no talent for fi ring. 
Very few people are involuntarily separated from 

the company headquartered in Redmond, WA, 
even after they’ve committed egregious blunders 
or exhibited total and complete incompetence. 
(Theft is another matter.)
As a result, Microsoft employs a lot of people 
that don’t contribute directly to the company’s 
bottom line. The areas that Ballmer said would 
be cut were largely support staff: IT, human 
resources, marketing, and so forth, rather than 
the muscle and sinew of the company, its core 
programming efforts.
It’s never a good day to lose one’s job, and one 
hopes that the most competent and able folks will 
be able to shift within the company to the new 
positions opening up.
And, by the way, Microsoft made $4.2 billion dol-
lars on $16.6 billion in revenue in the last quarter, 
and has $20 billion in the bank. These moves are 
expected to save them $1.5 billion a year in ex-
pense and $700 million in capital spending..

Microsoft Plans Shift in Business, Thousands of Layoffs
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First, fi nd the latitude and longitude coordi-
nates of your destination using a service such 
as iTouchMap.com. Next, make sure iMovie is 
not running and open the application’s package: 
Control-click on the iMovie application icon 
and choose Show Package Contents from the 
contextual menu. (iMovie, like many applica-
tions, is a Mac OS X “package,” a folder that 
appears normally as a 
single fi le.)
Go to Contents/Re-
sources/ and open the 
fi le WorldLocations.txt 
using a text editor. Copy 
an existing entry similar 
to the one you’re about 
to add; for example, 
fi nd a city in your state 
or country. Paste that at 
the end of the list, and 
change the city name. 
Then, copy the coordinates you looked up on the 
Web and paste them in place of the coordinates 
in your custom line.
Save the fi le, close the folders, and launch iM-
ovie. When you add a map and perform a search, 
your new location appears in the list.

The Date/Time Title

When you add this title style to a clip, the clip’s 
actual date and title appear. Only the start time is 
displayed - it won’t keep a running clock on your 
footage - and you can’t edit the text style. But if 
you need a quick notation of when the clip was 

shot, this title can save you some work.

View Photos from 

Same Time Period

If you’re like me, you capture not only video 
during a trip or other occasion, but also a lot of 
still photos. iMovie ‘09 makes it easier to fi nd 
the photos you shot at the same time.

Select an event in the 
Event Library and then 
click the Photos button 
on the toolbar. At the 
bottom of the Photos 
pane is a new Show 
Photos pop-up menu; 
click its checkbox and 
then choose a time 
frame (Within Event 
Date Range, or Within 
1 Day/Week/Month of 
Event).

Adjust the Opacity 

of a Cutaway

With the advanced tools enabled (an option in 
iMovie’s preferences that unlocks a lot of fea-
tures), you can drag one clip on top of another 
and create a cutaway - the new clip is super-
imposed on top of the existing one. When you 
bring up the Inspector on the cutaway clip, a new 
Opacity slider lets you adjust how transparent 
the clip appears..

by Doug McLean 

It’s been over a year since Apple introduced a major update to the Safari Web browser. Now the 
company has released a public beta of Safari 4, bringing a host of new features, interface enhance-

ments, and performance boosts.
The major changes include a new Top Sites feature that enables users to view and connect to their 
most-visited sites; Cover Flow integration for bookmarks and history; the relocation of tabs to the top 
of the window; an updated WebKit engine that features the new Nitro Engine that handles Javascript 
with improved speed; and a full set of developer tools..

Apple Releases Beta of Safari 4

Continued from page 4
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by Jeff Carlson

I’m one of those people who thought iMovie 
‘08 was pretty much okay. It advanced con-

sumer video editing on the Mac in several ways, 
such as having live transitions and effects that 
don’t require re-rendering clips and putting your 
entire video library at your 
fi ngers without opening old 
projects.
But iMovie ‘08, having 
been written from scratch 
as a new application, was 
sparse in many areas, es-
pecially compared to its 
predecessor, iMovie HD 
6. The good news is that 
iMovie ‘09 restores most 
of iMovie HD’s features. 
The better news is that iMovie ‘09 boasts a lot of 
other new features and hidden secrets that aren’t 
immediately apparent.
I’m hard at work on my book iMovie ‘09 and 
iDVD for Mac OS X: Visual QuickStart Guide 
and am enjoying discovering 
many of iMovie’s hidden tips 
and features. Here are 10 
things I’ve discovered that 
aren’t entirely obvious.

Double-click Clip 

to View Inspector

iMovie ‘09 now collects its 
adjustment controls in a new 
Inspector heads-up-display, instead of providing 
separate fl oating panels for video and audio ad-
justments. You can select a clip and click the “i” 
icon in the toolbar, or choose an option from the 
new Action menu that appears on every clip, but 
it’s easier to double-click the clip to bring up the 
Inspector. (If you prefer iMovie ‘08’s behavior of 
double-clicking a clip to play it, you can change 
the action in iMovie’s preferences.)

iMovie’s adjustment controls can also be invoked 
from the keyboard by pressing the following 
letters (with no modifi er key): I for Clip adjust-
ments; V for Video adjustments; A for Audio 
adjustments; and C for Cropping, Ken Burns and 

Rotation adjustments.

View Your 

Movie on a 

Secondary 

Display

 iMovie’s monitor occupies 
the top-right corner of the 
program’s interface, and it 
can be resized by choos-
ing one of the following 

sizes from the Window > Viewer submenu: Small 
(Command-8), Medium (Command-9), or Large 
(Command-0). That feature isn’t new, although the 
keystrokes have changed from iMovie ‘08.
What’s cool about iMovie ‘09 is that if you work 

with multiple displays, iM-
ovie can use one of them 
as the monitor to play back 
your movie. Choose Win-
dow > Viewer on Secondary 
Display. (If you don’t see the 
menu item, make sure Show 
Advanced Tools is enabled in 
iMovie’s preferences.) This 
feature not only gives you a 
larger preview - it scales to 

fi t the screen - but it removes the monitor from 
the iMovie interface, giving you more horizontal 
room for editing your project.

Copy and Paste Adjustments

One of iMovie ‘09’s new features is the return 
of video effects. With a clip selected, bring up 
the Inspector and click the Video Effect button 
to view the effects iMovie offers. Now, let’s sup-

10 Secrets of iMovie ’09
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pose that you also apply some other edits to the 
clip: increasing the exposure, muting the audio, 
applying image stabilization, changing its speed, 
etc. Quite a lot can happen to one clip, as you 
can see. If the following clip 
(or other clips) come from the 
same scene, you’d have to re-
apply all of those adjustments 
to make them match up.
Instead, Apple expanded on a 
powerful feature that deserves 
attention. With the adjusted 
clip selected, choose Edit > 
Copy or press Command-C; 
all of the adjustments are 
copied. Then, choose one or 
more clips and choose which 
edits to apply from the Edit > Paste Adjustments 
submenu, either all at once or piecemeal. iMovie 
‘08 could paste only video, audio, or crop adjust-
ments. This version also adds cutaway edits, 
video effects, stabilization, speed, and map style 
adjustments.

Move Projects and 

Events to Other Drives

In iMovie ‘08, events (the folders in which raw 
footage was stored on the hard disk) could be 
kept on your computer’s startup disk or on ex-
ternal disks, but your movie projects had to be 
located on the startup disk. iMovie ‘09 lets you 
choose where projects are stored, too.
You can also move projects from drive to drive, 
such as you might want to do if your startup disk 
runs low on space. Relocating event fi les in iMovie 
‘08 required that you move the applicable projects 
in the Finder. Now, drag a project or event to 
another drive’s icon in either the Project Library 
or the Event Library to copy the content. In the 
case of relocating project fi les, you’re given the 
option of copying just the project fi le or the fi le and 
its associated event footage, too. (Here’s a video 
example.) To move the fi les instead of copy them, 
hold the Command key while you drag.

Choose Which Clips Appear 

in Theme Transitions

iMovie ‘09 offers new themes that add mo-
tion graphics to your clips, 
specifi cally to your movie’s 
opening and closing scenes 
and some transitions. Some 
themes transition between 
two clips by, for exam-
ple, focusing on one clip 
“mounted” to a bulletin 
board, zooming out, and 
then zooming in on the next 
clip. Other transitions have 
several clips on the bulletin 
board.

You can choose which clips appear in which 
frames. Click one of the theme transitions to 
view a zoomed-out image that displays all of the 
available drop zones. A set of numbered yellow 
pins appears on your footage, each represent-
ing one of the drop zones. Drag the pins to the 
areas of your movie you want to appear in the 
other photos.

Consistent Map 

Styles in Themes

Speaking of themes, the Bulletin Board theme 
includes a map tacked onto the background of 
the board. If you already have a map in your 
project, or you add a new map, the map style on 
the board automatically assumes the same style 
from the project for consistency.

Add Locations to Travel Maps

iMovie includes an internal database of 4,000 
cities, airports, and other locations for use when 
adding markers to its interactive maps. That’s a 
good start, but what if you want a location that 
isn’t included? With a little work, you can add it to 
iMovie’s database. (Credit for this tip goes to user 
markstew on Apple’s iMovie discussion forums.)
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by Adam C. Engst

I’ve been laid up in bed following a hernia re-
pair operation last Wednesday (feeling better, 

thanks!), and while that’s undoubtedly making me 
crankier than normal, I’m having trouble muster-
ing any sympathy for the people who downloaded 
pirated copies of iWork ‘09 and Photoshop CS4 
and had their Macs turned into zombies participat-
ing in distributed denial of service attacks. Yeah, 
it sucks that those people are going to have to 
go to some effort to wrest back control of their 
Macs (for safety’s sake, I recommend absolution 
of a clean install of Mac OS X and applications, 
moving only documents and settings over) but 
let’s face it, anyone downloading this software 
was trying to get something for nothing. Oh, I 
know, it seems that copying software illegally is a 
victimless crime, but it’s now painfully clear that 
doing so also attaches a big “Practices Unsafe 
Hex!” sign to your back. Perhaps software piracy 
isn’t so victimless after all.
We’ve been saying for a long time that respon-
sible computing practices include avoiding un-
trustworthy sites and, especially, not download-
ing software from such sites. For the most part, 

Yet Another Reason Not to Pirate Software

we were thinking about the usual gambling, porn, 
and get-rich-quick sites that attempt to prey on 
our baser instincts. But with (unverifi ed) claims 
that as many as 20,000 people downloaded the 
pirated version of iWork ‘09, perhaps we’ve been 
remiss in not stating the obvious. The kind of 
people who post pirated software aren’t necessar-
ily the sort of people you want installing software 
on your Mac. And that’s just what you do when 
you download pirated software - you invite some-
one who’s intent on ripping off Apple or Adobe 
to do what they want with your machine.
So let’s not pretend that this Trojan Horse situ-
ation is in any way a normal security exploit or 
that people who suffered from it didn’t know 
that they were doing something wrong. They 
may not have known that their Macs would be 
dragooned into a denial of service attack, but 
they certainly knew they were doing something 
wrong. Not to get all preachy, but in this sort of 
situation, virtue offers not just its own reward, 
but also the reward of keeping your Mac safe 
from unsavory elements..

by Doug McLean

Apple has quietly released minor updates for 
the three applications in the iWork '08 suite: 

Keynote, Pages, and Numbers. The support notes 
for the Pages 3.0.3 update and the Numbers 1.0.3 
update, are terse and essentially uninformative: 
"This update addresses general compatibility 
issues." The Keynote 4.0.4 update notes give a 
little more information, stating that it primarily 
addresses compatibility issues with Microsoft 
PowerPoint 2007 and 2008. All updates are 
available via Software Update.
As much as it's disrespectful to professional users 
to restrict the release notes so completely, these 
updates send the much-appreciated message that 

Apple will continue to support the iWork '08 appli-
cations despite the recent release of iWork '09.
This practice is similar to Microsoft's continued 
support of Microsoft Offi ce 2004, which, though 
supplanted by Offi ce 2008, is still widely used. 
Although iWork '09 costs only $129, many 
users, especially those working in offi ces or 
schools with fi xed budgets, may not wish to 
purchase the new version, particularly if iWork 
'08 already meets their needs. So it's good to see 
Apple extending the bug fi xes and patches that 
are presumably included with iWork '09 to users 
of the previous version..

Apple Releases iWork '08 Update

Copyright 2009, TidBits Electronic Publishing
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If you like to keep your fi les or folders arranged in a certain order, by Date 
Created for example you can use the Finder’s View>Arrange By command.
The problem is the next time you create a new fi le or folder it is simply added 
at the bottom of the window.
To make sure your folders stay in your preferred order simply hold down the 
Option key while selecting View and you will notice that Arrange By command 
has changed to Keep Arranged By. Using this option will ensure that any new 
fi le or folder takes its correct place in the window.

and require you to save it elsewhere. Microsoft 
Word 2008 presents a clear dialog telling you 
to move the document out of the Trash or use 
Save As. Adobe Photoshop CS3 lets you open 
the fi le and make changes, but when you try to 
save, it forces a Save As without any explana-
tion. On my fi rst test with Adobe InDesign CS3, 
it crashed; subsequent tests merely closed the 
document without warning or explanation as 
soon as I opened it.
Testing would be required to determine how any 
given program will react to this situation, so if 
you rely on the Dock, Recent Items, or Open 
Recent as a launcher for in-progress documents, 
you may wish to check the applications you use. 
I haven’t tested Mac OS X 10.4 Tiger with regard 
to opening trashed documents, but I’d guess that 
the problem exists in that version as well.
Exacerbating the problem is the fact that Leop-
ard’s Time Machine doesn’t back up fi les once 
they’re in the Trash. It may have a backup of the 
fi le before it was moved to the Trash, but that 
could be signifi cantly out of date, were you to 
empty the Trash and then look to Time Machine 
to restore the most recent backup.

Who’s Responsible? 

From the varying results in my testing, it’s clear 
that responsibility currently lies with application 
developers to notice that an open fi le is located in 
the Trash and to prompt the user appropriately. 
Apple’s own programs appear to do that, and I 
strongly encourage developers to perform that 

check on either open or save, preferably open.
More generally, though, and the reason I think 
Apple should modify Mac OS X to eliminate this 
possibility of data loss, is that the Finder and the 
Dock behave differently in exactly the same situ-
ation, and the Finder itself displays inconsistent 
behavior. Double-click a fi le in the Trash, and 
the Finder forces you to move it before opening 
it. The Finder also warns you appropriately if 
you put a document in the sidebar or toolbar, 
trash the fi le, and then try to open it. But open 
a trashed fi le by clicking it in the Dock or from 
the Recent Items submenu, and... it just works 
(which is a bad thing, in this case).
For the sake of both consistency and safety, the 
Dock, the Recent Items submenu, and the Open 
Recent submenu in applications should refuse 
to open any fi le that’s stored in the Trash. And, 
ideally, the Finder should offer to move the of-
fending fi le to the user’s Desktop, rather than 
just presenting an error dialog. That would just 
be polite.
Plus, although fi xing this bug would address the 
issue of opening fi les in the Trash, I believe that 
Time Machine should back up the contents of 
the Trash, just like everything else, since it’s all 
too easy to create a fi le and trash it within the 
hour-long time frame that Time Machine oper-
ates, thus preventing Time Machine from ever 
seeing that fi le.
I’ve reported this problem to Apple, and with 
luck, it will be addressed in Snow Leopard..
Copyright 2009, TidBits Electronic Publishing
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by Doug McLean

Google Earth 5.0, the latest version of the 
popular 3D earth visualization tool, un-

leashes several major new features and loads of 
additional content. New additions announced by 
Google include the capability to view 3D bathy-
metric maps of the ocean's fl oor, thumb through 
historic maps and satellite imagery, explore the 
surface of Mars, and record journeys within 
Google Earth to share with other users.

The Oceans

While technically Google Earth has always 
included the oceans, until now that's consisted 
only of an expanse of 
blue with low resolu-
tion shading to indicate 
varying depths. In the 
new Google Earth 5.0, 
you can dive below the 
ocean's surface and ex-
plore the 3D terrain 
of the floor, as well 
as watch videos and 
gather information from 
various data points. The 
data points consist of 
text, videos, and links, 
which cover subjects ranging from animal track-
ing patterns and surf spots, to shipwrecks and 
historic expeditions. A great deal of this content 
is provided by National Geographic and Coust-
eau Ocean World. I had fun just plunging beneath 
the waters, crawling around, and randomly pop-
ping up to see where I'd travelled. To activate the 
Oceans layer, check the box next to Oceans under 
the Layer section of the sidebar.

Historical Imagery

The next best thing to time travel, the new His-
torical Imagery feature enables users to view 

maps and photos of any given location through-
out recent history. While the timeline is limited 
by the scope of Google’s image archive, for some 
locations this still means looking at imagery 60 
or 70 years old. For most locations in the United 
States though, information appears to date back 
only as far the late 1980s at best. However, for 
the launch of version 5.0 the Google team did 
put together some historic data sets for San 
Francisco and Las Vegas which are defi nitely 
worth checking out. This new feature is loaded 
with potential, and provides an easy way to ex-
plore the development of neighborhoods, cities, 

and the changing face 
of the environment. 
To activate the historic 
imagery feature, and 
its timeline slider, click 
the clock icon in the top 
menu bar.

Mars

Thanks to a collab-
oration with NASA 
researchers, Google 
Earth 5.0 introduces 
a new mode wherein 

users can explore the Red Planet. As one might 
expect, the 3D terrain imagery for Mars isn’t 
great, but Google does include other information 
such as signifi cant landmarks, featured satellite 
imagery, day/night infrared shots, and excerpts 
from the book “A Traveler’s Guide to Mars.” 
To activate the Mars mode click and hold the, 
um, Saturn icon in the top menu bar and select 
Mars.

Touring

Designed to make Google Earth even more of a 
shared experience, the Touring feature enables 

Google Earth 5.0 Adds Oceans, 

Mars, and Time Travel
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users to record journeys within Google Earth, 
along with accompanying narration. Likewise, 
users can download and watch tours that have 
been created by others. Check out Google’s Lat 
Long Blog to fi nd 
a handful of great 
Goog le  Ea r th 
tours for down-
load, including 
a Jimmy Buffett 
concert tour and a 
tour exploring the 
shrinking of the 
Aral Sea in Cen-
tral Asia since the 
1960s.
Unfortunately, the 
recording controls 
are fairly limited. 
Fo r  ex a m p l e , 
there’s no pause 
button, so tours 
must be recorded 
straight through from start to fi nish. Also, there’s 
currently no built-in way to export the fi le for 
viewing in a program other than Google Earth. 
Hopefully, in subsequent releases this feature 
will be further fl eshed out as it might be nice 
to share these tours via YouTube or Facebook. 
To activate the Touring feature, click the movie 

camera icon in the top menu bar.
Google Earth continues to demonstrate a com-
mitment to fun and interactive education with 
these excellent new features. Whether you’re 

a newcomer to 
the program or 
a veteran user, 
I highly recom-
mend checking 
out version 5.0. 
It’s a 35 MB 
download, and 
is available from 
the Google Earth 
Web page.
One caveat - in-
stalling Google 
Earth 5.0 also 
requires that you 
install the omni-
present Google 
Software Up-
date, which has 

generated complaints among those who want 
more control over what’s running on their Macs 
and when updates are downloaded and installed. 
At the moment, there is no supported method of 
disabling Google Software Update or running it 
only at specifi ed times..

by Glenn Fleishman

Before the close of trading on 21-Jan-09, the 
Wall Street Journal reported 

(using an anonymous source) that 
the SEC had opened an investiga-
tion into how Apple had disclosed 
information related to Steve 
Jobs’s health. Jobs, currently on 
leave from the company except 
for major strategic decisions until 
June 2009, has made a number 
of brief statements about his health over the last 

SEC Reportedly Investigates Apple over CEO Health

several months. 
Publicly traded companies are re-
quired to disclose matters that have 
a material effect on a company’s 
performance, which could include 
a CEO who was unable to perform 
as expected. The SEC typically only 
discloses their investigations when a 
settlement is made, fi nes imposed, 
or prosecution intended..

Courtesy of Telegraph.co.uk
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by Adam C. Engst
Consultant Scott Rose has isolated a potentially 
dangerous problem in Mac OS X 10.5 Leopard 
that could cause data loss for people who rely 
on the Dock or the Apple menu's Recent Items 
submenu as a launcher for in-progress docu-
ments. The steps to reproduce the problem aren't 
likely to bite careful users, but it's easy enough 
to see someone accidentally stumbling into the 
situation, as did one of Scott's clients.

The Problem

Assume you drag frequently used documents to 
the Dock for quick access, and once in the Dock, 
you use those Dock 
aliases exclusively 
for opening docu-
ments. Or, imagine 
that you use the Ap-
ple menu's Recent 
Items submenu or 
applications' Open 
Recent submenus 
to access your in-
progress documents. Further assume that for 
some reason, perhaps accidentally, you move one 
of these important fi les to the Trash.
Normally, if you double-click a file in the 
Trash, the Finder refuses to open it, telling you 

to remove it from the Trash fi rst. The warning 
makes perfect sense, since it would be all too 

easy to empty the Trash while working and lose 
your fi le.
However, if you open a trashed document via the 
Dock, the Recent Items submenu, or an applica-
tion’s Open Recent submenu, some applications 
allow you to open the document, make changes, 
and save your changes, all without the slightest 
warning. Were you to empty the Trash, your data 
would be lost, and you’d be left with no recourse 
short of a therapeutic bout of cursing. (And yes, 
this would defi nitely fall into the category of 
“user error,” but if Apple is going to prevent 
people from double-clicking fi les in the Trash, 

the least they can do is be consistent about other 
ways of opening fi les in the Trash.)
In a quick spot check of applications I use, pro-
grams that allowed editing of fi les in the Trash 
include Microsoft Word 2004 (but not 2008), 

Microsoft Excel 2008, 
and BBEdit 9.1.1. 
Scott Rose also tells 
me that he’s verified 
the problem in File-
Maker Pro (any ver-
sion), Quicken 2007, 
and Final Draft 7.
On the other side of 
the spectrum, Apple’s 

own TextEdit, Preview, Pages ‘09, and Numbers 
‘09 alert you that the fi le is stored in the Trash 

Finder Inconsistency Could 

Lead to Data Loss


